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Overview

e Customizable Tool Bars

* Case Info Displays

— Custom Case Info Displays

— Color Coded Case Information Display

— More Custom Floating Point and String Fields
* One-line Diagrams

— Customizable Bus Views

— Screen Layers

— Customization of Substation Objects
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Overview

e Data Improvements
— Interface Element Weightings and Nomograms
— Automated File Archiving
— Merge Buses
— New Interface Objects
e Contingency Analysis
— New Contingency Actions
— More report writing options
— Robust Solution Process
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Overview

* Power Flow Improvements: Island-based
AGC

* OPF/SCOPF

— OPF Maximum Violation Cost (Penalty Curve)
— Splitting MW Marginal Costs into components
— MW area to area transactions as a control
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Custom Tool Bars

Right clicking in the tool bar area brings up a local menu to
show, hide, create, or customize contents of tool bars

Feature Is similar to that commonly found in other windows
applications

Toolbars | Commands I Cptions I Toolbars — Cemmands I Cptions I
Toolbars: Categories: Commands:
‘Cace Information -~ a
IV File Case Info Madify R Sty :l
[V Pragram FEmanie, | Filz Case SUMMary, ..
Hel At
g g:?icr:l'nn.l'ld:ltn Delete | 0”5"”'35 % el
IV Zoom = Eptiﬂnfz'rmlos " Set Selected Field. ..
I_ E " pEE | ower Flow Optians
ora lselsiaon Case Info Options b 'H';' Bus Wiew, ..
I Edit Contouring e S
Iv Case Information Simulation *}é; Substation View, ..
I Insert | LP OPF N =

™ Pie Chart Cptions Descripion
[~ animated Flow Options

™ Contour Options

[ Solution Options Ll

|
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Custom Case Info Displays

 Create spreadsheet-like case info displays with any
type of information of interest

e Select Case Information -> Custom Case Info

{2 Custom Case Information Display E|E|

Default Custom Case Information lextra sheet ] Other sheet ] Maximize
A | B | C | D | E | F o~
1
4
3 Type to enter custom skrings | o
4 Top Gen 4 Area Mame
5 double-click on a cell to enter  95.0325 MW Gen 4 MW
B a model field YES Gen 4 AGC Status
T
8
9 W
£ »
Rename sheat Custnm. Casn.a Infa M?de= | | L cose
New Shest { Define Fields/Strings! ¢ Show Fields Primary
B (" hange Field Data (" Show Fields Secondary ? Help
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Other Case Info Improvements

Color-coded headings for key and required fields
Coloring of sorted columns

Avalilable centering of column text

Captions to identify the active advanced filter

New Custom Floating Point Fields and Custom
String Fields are available for most object types

— Buses
— Generators
— Loads
— Shunts
— Lines
— Etc...
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Customize Bus View

 Add custom fields
to bus view one-line

* Select Views ->
Define Custom
View from bus
view one-line

Add new object
fields to certain
positions

L:J Specify Bus Yiew Customization Settings

Swikch ko Cuskom Bus View

=10l x|

Dauble-click. on the Field entries or choose Madify. .. to change which Fields are shown at each position

1) Choose. ., 1) Choose.., 1) Choose. .,

Bus M

2 amz en MW oad MW 2) Choose, .,
BLISHamben en MYAR oad MYAR hunt MYAR

Mo ki 138,00 ky

Area: sreaname(nurm) Maodify... | Madify... | I Modify. .. |

Remaove |

Zone: zonenamednum)

Remove | Remave |

oltage W Flow
olt {k¥) 'Yar Flow
ngle YA Flow
W Marg Cost W Losses
5) Choose, ., 5 Choose..,
&) Choose, ., &) Choose..,

Choose. .. hioose..

Choose. ..

Modify... I Remove

Modify. .. I Remove

Set to Defaulk System State

0 | Remaove |
Set to Default Input Data |
To apply customizations o this Bus Yiew, ” |
choose the from dropdown at the right IMW LOS5ES j Sk
Save | Delete Renarme | Load From File |
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Screen Layers

* Add one-line objects to layers for customized views

» Select Options/Tools -> Screen Layers to create or
modify screen layers

* Assign Objects to Layers using the Format ->
Display/Zoom Level in Edit Mode

LY rd A O B A=
Screen Layers Find Object on Oneline. . .00 Mvar e RunMode Script Mode ~ | Lc
Layer Name | Shown |use Con Oneling Display Options. .. v Al SAUE . LAMER
1|Default Layer | YES NO Pan/Zoom Contral. . S —
2 |Layer 1 NO Area Information Dialag. ..
« Layer 1 [
|Layer 2 . . Edit Screen Lavers... v ':-“ 5 1
ayer
4 |Laver 3 TES MO Shaw Laver B . ki 4
5 [Layer 4 YES NO TG v ZLaver 1 80 MW « Laver 3
tink Oneline, .. o llieers
w Jlayer 2 ' ki
Copy Image to Clipboard a4 Layer 3 T
Export Image bo File, .. ¢ | H 0.
v Slaver 4 MV ar
Apply Template A= i E—
N SavelEdit/Delete Yiew, ..
N G0 ko Wiew
0 MW

lose |
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Customization of All Substation

Objects on a Display

« The general layout of a substation is specified In
the Oneline Display Options

* |f substations exist on your diagram, a tab will be
available labeled Substation
— Specify whether to use name/number for the identifier

— Specify extra fields which appear above, below, left and
right of the identifier

— Specify special symbols to appear in the corners of the
substation object

— Specify the relative sizes of all these fields and symbols

— Specify how to treat long identifier string (truncate or
shrink)
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Substation Object Customization

 Play with the settings on this dialog

— The upper right graphic will change accordingly.
Oneline Display Options =3

Display Options ] Pie Charts ] Animated Flows ] ThumbMail Yiew ] Memo ] Movie
Buffer %

Lpper %= of Height 0.0

Idertifier % of Height | 55.0 Subtation Identifier: Name

o (I
o| o
A4

Lawer %% of Height

LeFt %, of Width 0.0 Buffer % Lower Field: Min kv of Highest Mom kb
0o

Substation Identifier
0.0 {* Mamne " Mame (Murnber)
Right % of Width i Mumber i~ Mumber {Mame)
What should be done when identifier text does not fit inside the width
" Dwnamically decrease the font size sao that the string fits
{» Dynamically remove characters From the end of string

41k

Identifier % of Width [100.0

HRRENRR

.

Extra Substation Fields

Upper |Nn Field ﬂ Find... = :|= I
Lawer |Min kY of Highest Mam ky ﬂ Find... | Digits  |& ¥ Decimals |0 = [ Units?
Left  |NoField =| Find... i

4k

Right |Mo Field _w| Find... : =i
Upper-Left Symbol (LL) Upper-Right Symbol {UR)

{* MNang " Switched Shunk {* MNang " Switched Shunt
" Generatar " Mumber of Buses " Generatar " Mumber of Buses
" Load " Load

Lower-Left Symbal (LL) Lower-Right Symbal (LR)

{* MNaong " Switched Shunt {* MNaong " Switched Shunt
" Zenerator " Mumber of Buses " Generator " Mumber of Buses
" Load " Load

Save Options to Case. .. | X cancel | ? Help
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Other One-line Improvements

Multi-section line objects may be displayed as a single object
Instead of component lines.

Text on the oneline may be rotated.

All open onelines may be browsed simultaneously to find
objects.

Transformers may have different colors on the high and low
voltage sides

Pie Charts now display what their percentage Is based on
(MVA, Amps, etc...) and also what limit the percentage is
basedon (A, B, C, ...)

Save One-line Display Options
You may optionally hide the suffix of a text field

Keyboard short-cuts for Opening a specific Oneline diagram
to a Saved View
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Automated File Archiving

) E n ab I e S O I d £ Powerworld Simulator l]pl:ius E I _lolx]

Templates Simulation Lirnits
Power Flow Salukion Environment | oneline I Case Information Cisplays

versions of PWB . _ el

0% Tvar e

= [~ Auko Load Script: File £ i fosaris
I eS to e [~ Disable Showing Elackouts
¥ auto Open Bus Records if Mo Oneline ~Clack Skyle

i* Nane ™ Status Bar

. [T Disable AGC When Manually Changing Generakar Miy ;
automatically L ipekn

—Aukormatic Archiving of PWE files

rMeasurement Swskem

arC h i Ve d e aC h [¥ Enable Auto-Archive of PWE Files * English
Mazimurn Mumber of Archive Files IS 3, " Metric

t i | I I tl l I i I i Ak et e e Recently Used File Lisk Entries
e e e S " _ {underscore) e (Eilde)
. El w
- (dash) " ; [semicolom) I 3

" ather I

[~ Automatically Load Contingencies when Case is Cpened

saved

Contingency: File I j

/ (04 Save o Aux | x Cance| | '? ﬂeh:' |
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Interface Element Weightings

 Interface elements may have specified multipliers for
calculating interface flow by a “weighted sum of flows”

© Interface Dialog [Z|r§|g|
Interface Mame |2-5J 2-4 ﬂj Add MNew Interface

Interface Mumber 1 Find Inkerface. .. | Delete Interface |
Weightings
Limnts (MW Direction far Flow Monitaring  yaneontigrent My Flow l? / eC e
Lirnit A 65.0 5 S p I fl d
(¢ FROM-->TO Contignent M Flow 0.0

Lirnit B 0.0
r o Takal MW Flow 65.0
Limit 0.0 e

PTOF Value (%) 0.00 We i g h te d
Flows

Interface Elements lopF ]

Either  Insert Mew Element |

ar Right-Click ko show the Element Dialog

Description I eighting | I*‘ -Weight F#nw | Flow |
1| 0.60times the Line MW Aow from bus *Two" to bus Five l.'l 60 8189 49.14
2| 0.40times the Line MW flow from bus "Two' to bus ‘Fou 40064 16.26
T ®
\/ o4 | Save | x Cancel | ? Help Prink |
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Nomograms

 Nomograms allow definition of 2-dimensional limit
spaces using 2 interfaces

'y

Interface B &
» 0.6A+08B=104
- . "
— N
3 B=100" >~ _ N 5 !
(0,100)
(100,403 T"+,
~
L
~
3 »
Operating ™
Region A =100
(100,0)
& >
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» Select Case
Information ->
Nomograms to
define the
Nomograms,

Interfaces, and set

breakpoints

Nomograms

{0 Nomogram Dialog

Momagrarm |E:-:amp|e M omogram ﬂ
Save Save Ag | Rename | Delete
Interface & Inzert Mew Element | Clone Elements From ... |
| Description | '#Eighting| Flow

1 [Line MW flow from bus 'Two

{2} to bus 'Five  {5) circuit 1]

<

Interface B

i [nzert Mew Element |

Clane Elements From ... |

1.0000

| Description

1 [Line MW flow from bus 'Two

| 'vh'eighting| Flow

{2} to bus 'Four {4} circuit 1]

Momogram Breakpoints

Int & (] |Int B [Miw]
h 100.00 g
40.00 100.00 o
74.29 74.29 2
100.00 40.00 3
100.00 0.00
0K

Mamogram Limiting B oundary

1.0000

100

Operating
Region

0
0 10 20 30 40 50 60 70 30 30 100 1

Interface & [hw]

x Cancel |

______________

? Help |
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Merge Buses

» Combine loads, ~ EEERETREE - =l
generators, and
shunts from two or
more buses onto a
single bus

Delete

—Mew Bus Properties

* In Edit Mode, oo B 3
Nominal Yoltage | 100.000 =
select e MEBAIE
OptionS/TOOIS - Area Number 142 ﬁ Find
Zone Murnber 110 ﬁ Find
M e rg e B u Ses Substation 1 ﬁ Find

Merge Cancel |
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Other New Data Features

* New elements may be added to interfaces
— DC line flows

— Generator outputs: may be used to specify the total output
from a power plant (sum of generator outputs < max value)
— Load values

— Injection groups
 TLR/GSF: The “P Sensitivity” for out-of-service

buses may be set to the value at the closest in-service
bus

* Up to 8 transmission line and interface limit values
may be stored
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Contingency Analysis:
Nomograms

« Nomogram limit violations can be reported in
contingency analysis, and may also be binding in ATC,
OPF, and SCOPF analysis

@ Contingency Analysis

Cortingencies  Lines, Buses, Interfaces ]o;.ti-:.ns] Summary |
Lires) Transformers ] Buses ] Interfaces Momogram Interfaces }

Momo. Name |Numu. Seq. |'||'iu|al:iuns |Ma:-|: %o Luadirl
1 | Example Nomogram 1 0
2 [Example Nomogram 2 76.95
3 [Example Nomogram 3 10 106.93
4 Example Nomograni 4 10 109.53

Contingencies l Contingency Definition } ﬂ
Shiows Other Violations | Combined Tables = | |Actiuns

Label |Eategur‘r |'|||'a|ue |Limit Percent 1 |OPEN Branch Tw«
1 (L_000010ne-00003ThreeCl MNomogram MW 7992 107.33 74.46
2 |L_00002Two-00003ThreeC1 Nomogram Mw [ 81.45] 107.33 7589
3 |L_00D00ZTwo-000065ixC1 Nomogram MW 61.33 107.33 75.78
4 |L_00004Four-00005FiveCl Momogram MW 62.45 107.33 58.18
5 |L_00007Seven-00005FiveCl Momogram MW 82.60 107.33 76.95
b |L_000065ik-00007SeyenCl MNomogram MW 68.58  107.33 63.90
7 |L_0D0D006SiK-00007SeyenC? MNomogram ™MW 68.58 107.33 63.90

< >
Skakus |Finished with 30 Violations and 0 Unzolveable Contingencies. nitial Stat | Refresh Displays After Each Conkingency
Load | Auto Insert ‘ Save | Other > Skart Run | Close | ? Help |

&
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Contingency Analysis:
Report Writing

« New options for report writing

L:J Contingency Analysis

Contingencies I Lines, Buses, Interfaces  ©ptions | Summarsy I

[~ Case summary

[~ Option settings

[~ Monitared areas

[ Line Flow extremes

[T Interface flow extremes
[~ Bus vaolkage extremes
[~ Monitared zones

[~ Base-case outages

[~ all

—optional Report Contents——

—Identify buses by
" Mame

" Murmber
" Mame(Murnber)
% Mumnber(Marne)

[ Identify with Nominal Yolkage

[+ Show the actions involved in each contingency

[~ Repart only contingencies that cause violations

[~ Report anly limit bype with violations for each contingency

[~ Report Inactive Yiolations and show all Raking Sets

—Limit Type Yiolations to Include
[+ Line and Transformer Flows

[ Inkerface Flows
v Low Bus Yolages
[¥ High Bus Yolkages

[ Linef#fror Change Flows
[ Interface Change Flows
[ Low Bus Change Volkages
[~ High Bus Change Yolkages

Mazirnum Violations of a single bype ta repurtlgggg vl

[~ Create database-friendly tables

Field separatar: |$ "I

Product Repark

IModeling I Advanced Limit Moniboring | Advanced Modeling | pepart Wriking i

Miscellaneous

Status | Initialized

[ Refresh Displays &fter Each Conkingency

Set Options | Reset |

Close | ‘? ﬂelpl
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Contingency Analysis:
New Actions

e Solve power flow

L:J Contingency Case Dialog :_:5' il
F
Conkingency Label Ir'-.lew Conkingency jE fdd Contingency |
Insert Mew Element I Clear Al I Fename Conktingency I
Because this contingency includes a SOLYEPOMERFLOW element, the order of the elements is important, Sorting has been disabled. To change the order use the
buttons at the right.
Actions |Mudel Criteria |5l:al:u5 |Eummenl:| -
1 [DPEN Bus MCDOWELL {11273) | CHECK
2 |Solve Power Flow before proceeding CHECK =
3 |MOYE 100.00 % of present MW (cnst pf) LOAD AT BUS MCDOWELL (11273) TO BUS MEBAME (11274) CHECK
[T Use specific salution options Define Salution Sptions |
' OK | Save Delete | X Cancel | 7 Help |
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Contingency Analysis:
Robust Solution Process

L_ocated on

L:J Contingency Analysis

Contingencies I Lines, Buses, Interfaces Options |Summary

alculation Method
& Full Power Flow

Options ->
Modeling tab of

{~ Linearized Lossless DiC
{~ Linearized Lossless DiC With Phase Shifters

Limit Monitaring Settings ...

CTG Analysis
Dialog

[~ For i methods, allow amp limits by assuming
a canstant voltage magnitude

—Make-Up Power
When a contingency involving generationyload My changes or
outages does not specify how bo compensate For the losk powe
impork the required power From these sources:

etermine Make Up Using
% frea Participation Fackors specified below

{~ iGenerakor Participation Fackars From Entire Case Directly

{~ Same as Power Flow case

[+ Retry solution using the Robust Solution Process:

after a contingency solution Failure

Also available
on PVQV and
ATC analysis

[~ Use specific solukion opkions for contingencies

Define Contingency Salution Opkions

Area Num (Area Mame |CTG Make Up Gen | ﬂ
1 25(PIM500 0.0
2 26 [PENELEC 0.00
3 27 |[METED 0.00
4 28 [JCP&L 0.00
5 29 |PL 0.00
b 30 (PECO 0.00
7 31 |PSE&G 0.00
B 32 |BGRE 0.00
q 33 |(PEPCO 0.00
10 34 (AE 0.00
11 35 |DP&L 0.00

- —— 1 B

Modeling I.ﬁ.dvanced Limit Monitoring I Advanced Modeling I Report Writing I Miscellaneous I

Skatus Ilnitialized

[~ Refresh Displays After Each Contingency

Set Opkions | Reset |

Clase | ? ﬂelpl
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Other Contingency Improvements

May now specify “Load Throwover” records for
buses so that loads automatically move if they are
outaged during a contingency

Better support for islands created during
contingencies when using the linearized AC or DC
methods

Record the total amount of load islanded during a
contingency

Available script commands for auto-inserting
contingencies.
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Island-Based AGC

 Allow load and
generation
balancing across

i ijce Participation Factors of individual generators:
- I d ™ Calculation Participation Factors from Area Make Up Power Yalues
an 1Siand,

Instead of Areas
or Super Areas

Options
used for
Injection
Group

Dispatch

N\~

C

2 PowerWorld Simulator Options

Island &aC Tolerance I 5.0000 f

~Island-based Automatic Generation Control (AGEC)
" Disable {Use the Area and Super Area Dispatch setkings)

" Dispatch using an Injection Group {Loads and Senerators will respond)

Specity Area Make Up Power Yalues |

Injection Group iame [T allow anly &EC Uribs b vary

I j [T | Enfarce unit F limits

[T Do not allow negative loads

ow shiould reactive power load change as real power load is ramped?

[T Eeep the ratio bebween real and reackive power conskant &t each load

OB -
& MW changes, change MYR at a power fackar of I 1.oo =

=10] x|

Pawer Flow Solution |Enviru:unment I Oneline I Case Information Displays I Templates | Simulation I Limits I

Solution Cptions  Island-Based &sC I DiZ Opkions I General I Skorage I

Restore Defaulks

W OF Save ko Aux | X Cancel | ? Help |
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Other Power Flow Improvements

Switched Shunt Control Range: Specify different target
voltages after reaching high limit vs. low limit

Modified Line-Drop-Compensation: all generators at a bus
perform LDC voltage control together

Improvement to the optimal multiplier technique for
calculating power flow solution near voltage collapse

Tap-changing transformers (LTCs) which are in parallel with
each other now coordinate their switching actions so they
maintain similar taps

Continuous Switched Shunts are treated directly in the power
flow equations as “PV buses”

You may now specify Post Power Flow Solution Actions

— represent conditional actions that occur at the end of every power flow
solution

— Example would be loads that turn off if the voltage is too low.
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Specifying a Piece-wise Limit Cost

with the Limit Groups
o Starting in Simulator 10.0, each Limit Group can
specify a piece-wise limit cost which will then

override the maximum violation cost specified In
the OPF

— Go to Case Information, Limit Monitoring Settings
— (o to the Modify/Create Limit Groups tab

— Right click on your limit group and choose Show
Dialog.

— On the right side of this dialog, you may define the
limit cost
e This allows for a more complex penalty function
as shown on next slide

— This allows the OPF to “dispatch’” the amount of
overload similar to a generator dispatch
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A Penalty Cost

Specifying a Piece-wise Limit Cost

with the Limit Groups

Piece-wise Linear Limik Cosk
v s Limit Cosk

Moke: The cosk Funckion musk be skrickly
increasing

Slope =

($/hour) 1000 $/MWhr
50.$/MWhr
Slope = \
10.$/MWhr
[ >
100% of 105% of 110% of Violation

Limit Limit Limit

Amount MVA  N-28



Area Transactions as OPF Controls

* You may now define an area-to-area MW
transactions which can be dispatched by the OPF

— You must give the transaction a Minimum/Maximum
transfer amount

— Allow OPF to determine the price

« If both areas are on OPF, then it will just figure out the
appropriate amount of transfer and price (within the range
specified)

— Or may enter a Cost Curve for the transaction

* If one area is on OPF, and the other is on Part. Factor, then
this the area on OPF will “dispatch” the area on part.
Factor as though it’s a big “generator”
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Area Transactions as OPF Controls

Specify a Min/Max
Range for transfer

AN

Check to allow
dispatch

Check to have OPF
determine price__—

> Transaction Dialog
Transackion ID

Specify an Export Cost Curve
and and Import Cost Curve

wporking Area | 1(Top

1 ﬂ Transackion IO

Imporbog Area

Information Ngermo ]

Transaction My Armsgnk
Transaction Minirmunm P
Transac Lion Mairmurn MW

Transmission Charge

[ Transaction Enabled

| Ly Determine Price in COPF

2 {Left )

\4|7 Transaction Dispatchable in OPF

ﬂ Renamxransactinn Id

Piecewise Linear Trangaction Cost Curves
Mote: the cost Funckign must both be skrickly increasing.,
Export Transactio Irnport Transackns

MW | ¥ $/mwh | MW [ Y $/Mwh
50.00] 20.00 &0.00] 25.00
100.00 30.00 120.00 35.00

ECE
ECT
[Tooon
o

(cost curves will not

Save | X cCancel ? Help

be used then)

N-30



OPF Splitting of MW Marginal Cost
Into Losses, Energy, Congestion

* This was covered in OPF Section

— The components of Loss, Energy, Congestion sum
to the total MW Marginal Cost

— Must specify a reference for Energy
 Allows you to calculate a cost of energy

— Must specify a reference for Losses
 Allows you to calculate a cost of losses

— Cost of Congestion Is the leftover

— The way these values are “split up” is arbitrary
depending on references choosen

— The MW Marginal Cost is UNIQUE however
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Other OPF/SCOPF Improvements

 Load Multipliers to approximate losses for DC
solution method

* Load available as an SCOPF Control
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